
Contents for KickOff Help
This file contains the combined help for KickOff and KickEdit.
To learn how to use Help, press F1.
Introduction
What is KickOff?
What is KickEdit?
License Agreement/Warranty
Ordering Information
How To...
Install KickOff and KickEdit
Uninstall and Cleanup should you decide not to register
Help On...
KickOff - The Launcher
KickEdit - The Menu Editor



KickOff Help
KickOff is a tool you can use to easily start applications, and organize your applications and 
files into logical groups.    
To learn how to use Help, press F1.
How To...
Display the Menu
Launch an Application
Select the KickOff Mouse Button
Hide and Show the KickOff Icon
Reload Menu Definitions
Commands
System Menu



KickEdit Help
KickEdit is a visual editor which allows you to easily configure KickOff menus.
To learn how to use Help, press F1.
How To...
Add Menu Items
Edit Menu Item Properties
Change an Items Icon
Arrange and Organize Menus
Copy Program Manager Groups
Commands
The Menubar
The Toolbar



What is KickOff?
KickOff is a program and file launcher which uses a hierarchy of popup menus to organize 
your applications.    The menus display an icon as well as a description for each item, and 
they take up no space on your desktop until you ask for them.    Once you have selected an 
item, the menus disappear until you need them again.

Click here to see a sample menu
Why Program Manager is difficult to use.

1. Cannot    define groups within groups.    
This limits your ability to arrange your items logically the way you use them.

2. It takes up screen space just like any other application.
If you want your applications just a mouse click away, you must share valuable 
screen space with the Program Manager window.

3. Cannot see all icons at once.
If you are like me, you have lots of programs. To launch an application, you must 
close one or more group windows in order to find and open the group that you want 
to launch from. 

4. Cannot customize group icons.
This makes finding the group window to open a description reading exercise.

5. Cannot launch applications if Program Manager is covered by other windows.
You must close or minimize other application windows to uncover program manager, 
before you can even begin looking for the group containing the application you wish 
to launch.

What makes KickOff better?
1. You can define groups within groups.

Nest your groups to any depth.    Finally you can have it the way you want it.
2. Absolutely no screen space required.

All applications are a mouse click away without reserving any space on your desktop. 
Simply click the mouse button you choose on the desktop, or any titlebar or menu, to
bring KickOff menus on top of whatever you are doing.

3. All your applicatons are available without opening an closing windows.
Instead, they are in convenient submenus, organized the way you want them.

4. You can customize group icons.
The ability to personalize the icon for each group helps you to identify groups without
having to read the description.

5. You can launch applications anytime, even if you have other windows maximized.
Simply click the mouse button you choose on the desktop, or any titlebar or menu, to
bring KickOff menus on top of whatever you are doing.

Does KickOff replace Program Manager?
Not a the moment.    You take no risk by running KickOff because it does not change 
Windows in any way.    Future enhancements will give you the option to completely replace 
Program Manager should you want to.



Sample KickOff Menu



What is KickEdit?
KickEdit is the KickOff menu editor.    It is a highly intuitive, what you see is what you get, 
editor with a full drag and drop interface.    Along with the ability to manually create groups 
and items, it can also create menu groups from program manager and accept files dropped 
from file manager.    You will use it whenever you want to change your menu layout.
Key Features
      Editor displays your menus exactly as they actually appear.    They also behave exactly 

like the real thing.
      Fully visual, intuitive, WYSIWYG interface.    No need for trial and error menu design.    No 

complex .INI files to learn.
      Manual program and group item creation using dialogs similar to Program Manager.
      Drag files from File Manager, and drop them into your menus.    
      Select Program Manager groups from a list, and automatically add identical groups to 

your menus.    This feature is great after installing    a new product.
      Rearrange menus by dragging groups or items to a new location.



License Agreement/Warranty
License Agreement and Warranty Disclaimer
You should carefully read the following terms and conditions before using this software.    Use
of this software indicates your acceptance of these terms and conditions. 
Shareware Version
You are hereby licensed to:    use the Shareware Version of the software for a reasonable 
evaluation period; make as many    copies of the Shareware version of this software and 
documentation as you wish; give exact copies of the original Shareware version to anyone; 
and distribute the Shareware version of the software and documentation in its unmodified 
form via electronic means.    There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, 
however made; and from distributing the software and/or documentation with other products
(commercial or otherwise) without prior written permission, with one exception:    Disk 
Vendors approved by the Association of Shareware Professionals are permitted to    
redistribute KickOff, subject to the conditions in this license, without specific written 
permission.
Evaluation and Registration
This is not free software.    This license allows you to use this software for evaluation 
purposes without charge for a reasonable period of time.    If you decide to continue to use 
this software, a registration fee of $25 is required.    Payments must be in US dollars drawn 
on a US bank, and should be sent to Steve Sutherland, P.O.    Box 20654, Tampa, FL 33622-
0654.

One registered copy of KickOff and KickEdit may be dedicated to a single person who uses 
the software on one or more computers or to a single workstation used by multiple people.

You may access the registered version of KickOff and KickEdit through a network, provided 
that you have obtained individual licenses for the software covering all workstations that will
access the software through the network.    Site licenses are available as specified on the 
order form.
Governing Law
This agreement shall be governed by the laws of the State of Florida.
Disclaimer of Warranty
This software and the accompanying files are sold "as is" and without warranties as to 
performance of merchantability or any other warranties whether expressed or implied.    
Because of the various hardware and software environments into which this software may be
put, no warranty of fitness for a particular purpose is offered.

The user must assume the entire risk of using the software.    Any liability of the seller will be
limited exclusively to product replacement or refund of purchase price.



Registration Form/Invoice
Registration/Orders
Payments can only be made by check or money order.    To register or place an order, send 
this form and a check or money order to Steve Sutherland,    P.O. Box 20654, Tampa, FL 
33622-0654.    Payments must be in US dollars drawn on a US bank.    You will receive a 
registration number which will continue to be valid for all future versions of KickOff.
Site licenses
A site license for KickOff entitles an organization to receive one copy of the distribution 
package and duplicate the distribution disk for the specified number of copies.    You may 
also install the Licensed copy of KickOff and accompanying files on a network, as long as 
steps are taken to ensure that the total number of concurrent uses does not exceed the 
specified number of copies.

Please check one: 5.25" Disk        ____  
                  3.5" Disk         ____ 
                  Just Register     ____

KickOff single copy: quantity ___ @ $25.00 ea.  = _________
Site license for up to 10 copies:  $150.00      = _________
Site license for up to 25 copies:  $300.00      = _________
Site license for up to 50 copies:  $500.00      = _________
    (more than 50 copies are negotiable)
                                 Total payment    _________

             Name: ________________________Date:___________
 
          Company: ________________________________________

          Address: ________________________________________

 City, State, Zip: ________________________________________

          Country: ________________________________________

        Day Phone: _______________  Eve:  _________________

 How did you hear about KickOff? __________________________

 Comments:



Installing KickOff
Files Included on the Disk

CTL3D.DLL Microsoft supplied DLL to implement 3D 
controls.

KICKDLL.DLL KickOff routines common to KickOff and 
KickEdit.

KICKEDIT.EXE The KickOff menu Editor
KICKOFF.EXE The menu launcher itself
KICKEDIT.HLP This help file.
README.TXT Last minute notes and introductory text.

Installing Kickoff
1. If you are installing KickOff for the first time, create a new directory for the files.    A 

suggested name might be 'C:\KICKOFF', but you are free to choose what ever you 
want.    If you have an older version of kickoff installed, you will just use the same 
directory that the older version is installed in.

2. Copy all of the files (listed above) into the KickOff directory.
3. Add KICKOFF.EXE, and KICKEDIT.EXE to a group in Program Manager.    If you are not 

sure how to do this, consult the Program Manager Help on adding new items.
4. If you want KickOff to be available everytime you start Windows, add KICKOFF.EXE to 

the Program Manager Startup group.
Creating your first menus
If you are installing KickOff for the first time, you will need to define your menus before you 
can use them.    Fortunately, KickEdit will help you if you wish, by offering to create an initial 
set of menus from your Program Manager groups.    These menus won't be pretty, but you 
can customize and rearrange them to make them suit your tastes.    To create your first 
menus, follow these steps:

1. Start the KickOff menu editor (KICKEDIT.EXE).
2. Upon noticing that there are no menus currently defined, your will be prompted 

whether you want to create your initial menus from the Program Manager groups.    
Your response to this is up to you.    

If you choose Yes, 
Every single Program Manager group will be added to the main menu 
automatically.    

If you choose No, 
You will be presented with a menu with a single item in it.    You can then add 
Program Manager groups individually using the Edit | Program Manager menu 
option.

3. Move, rearrange groups, change properties, customize to your hearts content.
4. When you have the menus looking the way you want them, choose the Save option in

the File menu to save your changes.    If KickOff is already running, you will be asked if
you want the changes to update the running menus (In this case choose Yes).

5. If it is not already running, start KickOff (KICKOFF.EXE) and begin using your menus.



How to Uninstall KickOff
Changes Made to Your System
KickOff makes no changes to system files.    There is one file created in the Windows 
directory to save your menu definitions (KICKOFF.INI), and one to save your editor settings 
(KICKEDIT.INI), but otherwise, all files are where you installed them.
To Remove KickOff from Your System

1. Delete KICKOFF.INI, and KICKEDIT.INI from your \WINDOWS directory.
2. Delete the files from the KickOff directory you created at install time.
3. Delete the KickOff directory.
4. Remove the KickOff and KickEdit Icons from Program Manager.



Displaying the Menu
One of the key features of KickOff is that the menus take up no screen space, and are always
available with only a single mouse click.    
To Display the KickOff Menu

    Click the KickOff mouse button on any exposed portion of the Windows desktop.
Or Click the KickOff mouse button on any titlebar, menubar, titlebar control, or minimized 
window.

The KickOff mouse button is by default the right button.    For systems with a middle mouse 
button, you may optionally choose to use that to activate KickOff menus.    



Launching an Application
KickOff's main objective is to launch applications quickly and conveniently.    
To Start an Application

    Display the KickOff menu with the KickOff mouse button, then click on the item you wish 
to start.      
If the item you want is in a group, then you will need to click on the group to display its 
items and select from there. 



Selecting a Mouse Button
The KickOff icon's menu has an item which lets you choose which mouse button to use to 
activate the menus.
To Select a Mouse Button

    Choose the Mouse option on the KickOff icon's system menu.    Select Right Button or 
Middle Button to select the desired activation button.
Once selected, this is the button you will use to 'popup' the KickOff menus.    If you had 
previously hidden the KickOff icon, you will need to redisplay it first by starting KickOff again
without shutting it down.      

See Also...
System Menu



Hiding and Showing the KickOff Icon
The KickOff icon's menu has an item which lets you hide the icon now, and whenever KickOff
starts, until you redisplay it again.
To Hide the KickOff Icon

    Choose the Hide Icon option on the KickOff icon's system menu.    
The icon will disappear, and will stay hidden even across restarts.
To Redisplay the KickOff Icon

    Start KickOff a second time from Program Manager, and the icon will reappear.    
Rather than actually starting a second time, KickOff instead redisplays the hidden icon, 
which will now remain visible, even across restarts.

See Also...
System Menu



Reloading the Menus
The KickOff icon's menu has an item which lets you force KickOff to reload its menus.    This 
is usually not necessary since the editor will reload the menus for you.
To Reload the Menus

    Choose the Reload Menus option on the KickOff icon's system menu.    
KickOff will reload the current menu definitions.

See Also...
System Menu



The KickOff System Menu
Click menu item for help on that item



Middle Button (System menu)

    Choose this to select the middle mouse button as the KickOff activation icon.
If your mouse does not have a middle button, then you will not be able to activate the 
menus until you switch to the right button.

See Also...
Selecting the KickOff Mouse Button



Right Button (System menu)

    Choose this to select the right mouse button as the KickOff activation icon.

See Also...
Selecting the KickOff Mouse Button



Reload Menus (System menu)

    Choose this to force KickOff to reload its menus now.
This is usually not necessary since the editor will allow you to reload menus when saving 
changes.

See Also...
Reloading Menu Definitions



About (System menu)

    Choose this to display version, copyright notice and registration information.



Close (System menu)

    Choose this to quit KickOff. 
Your preferences will automatically be saved.



Mouse (System menu)

    Choose this to display the submenu of mouse button choices. 
Select which mouse button to use for KickOff menu activation.

See Also...
Selecting the KickOff Mouse Button



Switch To (System menu)

    Choose this to switch to any other running application. 



Hide Icon (System menu)

    Choose this to hide the KickOff icon. 
Once hidden, the icon will remain hidden until you start KickOff a second time to redisplay 
the icon.

See Also...
Hiding and Showing the KickOff Icon



KickOff Icon

    Click on this to display the System menu. 



Move (System menu)

    Choose this to move the KickOff icon. 



KickEdit Toolbar
Click on any button for help on that button

The toolbar provides an alternative method of executing common commands.    KickEdit's 
toolbar looks like the above.    Click on any button to get help on that button.



KickEdit Menus
Click menu item for help on that item



Paste (Edit menu)

    Choose this to insert a copy of    the contents of    the clipboard into the menu at the 
focused item.

See Also...
Copying a Menu Item
Moving a Menu Item



Properties (Edit menu)

    Choose this to change the properties of the focused item.

See Also...
Program Item Properties Dialog
Group Item Properties Dialog
Editing Menu Items



Program Manager (Edit menu)

    Choose this to add copies of selected Program Manager groups into the menu at the 
focused item.

See Also...
Program Manager Dialog
Copy Program Manager Groups



Copy (Edit menu)

    Choose this to copy the focused item to the clipboard.
If the item is a group item, the entire contents of the group as well as any sub groups will be 
copied to the clipboard.

See Also...
Copying a Menu Item
Moving a Menu Item



About (Help menu)

    Choose this to display version, copyright notice and registration information.



Index (Help menu)

    Choose this to display help for KickOff and KickEdit.



Status Bar (View menu)

    Choose this to toggle the status bar on and off.      
A checkmark indicates the status bar is displayed.



Toolbar (View menu)

    Choose this to toggle the toolbar on and off.
A checkmark indicates the toolbar is displayed.



Delete (Edit menu)

    Choose this to delete the focused item.
If the item is a group item, all contained items and groups will also be deleted.    

See Also...
Deleting a Menu Item



New (File menu)

    Choose this to initialize the editor with a new empty menu. 
A single program item for KickEdit itself will be added automatically.



Confirmation (Options menu)

    Choose this to change the level of warnings displayed prior to destructive editing actions.

See Also...
Confirmation Dialog



Save Settings on Exit (Options menu)

    Choose this to toggle automatic saving of editor preferences on and off. 
A checkmark indicates preferences will be saved when you exit KickEdit.



Using Help (Help menu)

    Choose this to display help on the help program.



Exit (File menu)

    Choose this to exit KickEdit.    
You may be prompted to save any changes made to the menus.



Load (File menu)

    Choose this to load the current KickOff menu definitions into the editor.



Save (File menu)

    Choose this to save the contents of the editor.
If KickOff is running, you will be asked if you want to refresh the active menus as well.



Cut (Edit menu)

    Choose this to delete the focused item and place it in the clipboard.
If the item is a group item, all contained items and groups will also be deleted, and added to 
the clipboard.

See Also...
Deleting a Menu Item
Moving a Menu Item



New (Edit menu)

    Choose this to insert a new group or program item into the menu at the focused item.

See Also...
New Item Dialog
Adding Menu Items



New Item Dialog
Click on any control for help on that control.

Specify the type of new item to create.    The new item will be inserted at the focused item in
the menu.

See Also...
Program Item Properties Dialog
Group Item Properties Dialog
Adding Menu Items



OK

    Choose this button to create a new item of the specified type.
Depending on your choice, the Program Item or the Group Item dialog will appear next.

See Also...
Program Item Properties Dialog
Group Item Properties Dialog
Adding Menu Items



Cancel

    Choose this button to exit the dialog without creating a new item.



Help

    Choose this button to display help on this dialog.



Program Item

    Choose this button to create a new program item.
The new item will be inserted into the menu at the focused item.

See Also...
Program Item Properties Dialog
Adding Menu Items



Group Item

    Choose this button to create a new group item.
The new group will be inserted into the menu at the focused item.

See Also...
Group Item Properties Dialog
Adding Menu Items



Group Item Properties Dialog
Click on any control for help on that control.

Customize the description, and the icon displayed on the group item.

See Also...
Change Icon Dialog
Adding Menu Items
Editing Menu Items



OK

    Choose this button to accept and apply all property changes made.



Cancel

    Choose this button to discard any property changes made and exit the dialog.



Change Icon

    Choose this button to change the icon to be displayed for this program item.

See Also...
Change Icon Dialog
Change an Items Icon



Help

    Choose this button to display help on this dialog.



Icon

Displays the current icon which will appear in the menu for the group item.



Description

    Type the name of the group item as you would like it to appear next to the icon in the 
menu.
The description is optional.    If you leave this box blank, KickEdit names the group for you.



Program Item Properties Dialog
Click on any control for help on that control.

Customize the description and icon displayed, the program launched, default directory and 
startup mode for the program menu item.

See Also...
Change Icon Dialog
File Browse Dialog
Adding Menu Items
Editing Menu Items



OK

    Choose this button to accept and apply all property changes made.



Cancel

    Choose this button to discard any property changes made and exit the dialog.



Browse

    Choose this button to display a Browse dialog for selecting an application for the 
Command Line box.

See Also...
File Browse Dialog



Change Icon

    Choose this button to change the icon to be displayed for this program item.

See Also...
Change Icon Dialog
Change an Items Icon



Help

    Choose this button to display help on this dialog.



Icon

Displays the current icon which will appear in the menu for the program item.



Description

    Type the name of the program item as you would like it to appear next to the icon in the 
menu.
The description is optional.    If you leave this box blank, KickEdit names the icon for you.



Command Line

    Type the name of the applications program file, including the extention and path, if 
necessary.
If you don't know this information, use the Browse button to open the Browse dialog box.

See Also...
File Browse Dialog



Working Directory

    Type the path of the directory where your application's program files and documents are 
located.
The working directory is optional.    If you leave this box blank when first creating the 
program item,    the directory where the program file is located is the working directory.    If 
you leave this box blank when changing a program item's properties, the Windows directory 
is the working directory.



Normal

    Select this button if you want the application to always start in its default size and 
position.



Minimized

    Select this button if you want the application to be reduced to an icon every time it 
starts.



Maximized

    Select this button if you want the application to grow to its maximum size every time it 
starts..



Focused Item

The menu item in the editor which is currently being acted upon.    It can be distinguished 
from other menu items by the box which surrounds it.



Change Icon Dialog
Click on any control for help on that control.

Choose an icon to be displayed from those available in the specified file.

See Also...
Change an Items Icon



OK

    Choose this button to close this dialog and apply the selected icon to the menu item. 
If you just changed the icon file in the File Name box, then this button will reload the Icon list
with any icons from the new file.



Cancel

    Choose this button to close this dialog, ignoring any changes made.



Browse

    Choose this button to select an icon file from a Browse dialog.

See Also...
File Browse Dialog



Help

    Choose this button to display help on this dialog.



Icon List

    Scroll through the icons by clicking the scroll arrows or by using the LEFT and RIGHT 
ARROW keys. Select the icon you want to use, and then press ENTER or choose the OK 
button. 



File Name

    Type a new filename, if needed. You can choose an icon from another application by 
typing the name of the program file for that application, and pressing ENTER or pressing the 
OK button.    If you do not know this information, you can also choose Browse and select a 
file Browse dialog.

See Also...
File Browse Dialog



File Browse Dialog
Click on any control for help on that control.

Use this dialog box to easily find and select files.



OK

    Choose this button to return the selected file to the application. 
This button will be disabled unless you have selected a file.



Cancel

    Choose this button to close this dialog, ignoring any changes made.



File Name

    Select the name of the file you want, and then choose the OK button.
Or type the filename in this box, and then choose the OK button.    If necessary, also 
specify a path and drive.

If the file you want does not appear in the File Name list, you can change drives or 
directories, or specify a different file type.



Drives

    Open the list, and then select the drive which contains the file you want to use.    When 
you change drives, the directories on that drive appear in the Directories box.



Directories

    Select the directory which contains the file you want to use.    When you change 
directories, the files in that directory appear in the File Name box.
If the directory you want does not appear in the list, you may have to change drives by 
choosing a different drive from the Drives list.



List Files of Type

    Open the list, and then select the type of file you want displayed in the File Name box.
For example, if you select Programs, the File Name list displays only program files (files with 
an .EXE, .PIF, .COM, or .BAT filename extension).



Help

    Choose this button to display help on this dialog.



Confirmation Dialog
Click on any control for help on that control.

Specifies whether comfirmation messages are displayed.



OK

    Choose this button to close this dialog and apply changes made.



Cancel

    Choose this button to close this dialog without applying any changes.



Help

    Choose this button to display help on this dialog.



Group Delete

    Check this item if you would like to be warned before deleting a group item.



Item Delete

    Check this item if you would like to be warned before deleting a program item.



Program Manager Dialog
Click on any control for help on that control.

Insert selected Program Manager groups into your menu, at the focused item.



Insert

    Choose this button to create and insert a new group in your menu for each selected 
Program Manager group in the group list.    
Each group will automatically be filled with the items exactly as they are currently defined in
Program Manager.



Close

    Choose this button to close the dialog.



Help

    Choose this button to display help on this dialog.



Group List

    Select one or more groups to be inserted into your menu.
This contains a list of all the groups currently defined in Program Manager.    When you have 
made your selection, choose Insert    to create and insert the group and its contents into your
menu at the focused item.



Adding Program Items
A program-item icon represents an application, accessory, or document in a KickOff group. 
By choosing the icon for a program item, you start the application or accessory, or open the  
document. You can create a program item in one of three ways:    Manually enter the 
information for the item, or drag a program or document file from File Manager and drop on 
a KickOff group, or create an entire group from Program Manager complete with all of its 
defined program items. 
To create a program item manually

1. Open the group menu that you want to add an item to. 
2. Select the item in the group where you want to insert the new item.
3. From the Edit menu, choose New. 

Or press the INSERT key.
Or click the right mouse button over the focused item and choose New.

4. In the New Item dialog box, select the Program Item option, and then choose the OK 
button. 

5. Fill in the Program Item Properties dialog box as necessary, and choose the OK 
button. 

To add a new menu item using File Manager drag-drop
1. Open the group menu that you want to add an item to.
2. Open File Manager and select the file or files you want to add to your menu.
3. Drag the files from File Manager and drop onto a KickOff, positioned where you want 

the file(s) to be inserted.
4. The items will be inserted with a suitable default description and icon.

See Also...
Copying Program Manager Groups
New Item Dialog
Program Item Properties Dialog



Editing Menu Items
Once you have created a program item or group, you can go back and change its properties.
For program items, you can change the description of the item, the working directory where 
files that the application creates are stored, the icon that KickOff uses to represent the 
application, and whether the application is minimized to an icon whenever you start it. For a 
group, you can only change the description, and the icon that KickOff uses to represent the 
group. 
To change the properties of a program item or group

1 Select the menu item for the program or group item to change.
2 From the Edit menu, choose Properties. 

Or press ALT+ENTER. 
Or click the right mouse button over the focused item and choose Properties.

3 In the Program or Group Item Properties dialog box, change properties as needed. 
4 Choose the OK button. 

See Also...
Program Item Properties Dialog



Changing Icons
If more than one icon is available for a program item, you can change the icon.    You can 
also choose an icon from another application or icon source for any Program or Group item.
To change an icon

1 Select the Program or Group item for which you want to change the icon. 
2 From the Edit menu, choose Properties. 

Or press ALT+ENTER. 
Or click the right mouse button over the focused item and choose Properties.

3 In the Program or Group Item Properties dialog box, choose the Change Icon button. 
4 If more than one icon is available in the Current Icon area, scroll through the icons by 

clicking the scroll arrows or by using the LEFT and RIGHT ARROW keys. If you would 
like more icons to choose from, you can scroll through all the available icons in other 
Windows programs.    In the File Name box, type the file name of the icon source to 
use and press ENTER. 

5 When the icon you want to use is selected, choose the OK button. 
6 In the Program or Group Item Properties dialog box, choose the OK button. 

See Also...
Program Item Properties Dialog
Change Icon Dialog
File Browse Dialog



Arranging an Organizing Menus
Using KickEdit, you can organize your applications and files into groups that make sense to 
you. For help with organizing menus, choose one of the following topics: 

Adding Menu Items
Changing Menu Item Properties
Changing an Items Icon
Copying a Menu Item
Deleting a Menu Item
Moving a Menu Item



Copying Groups from Program Manager
Program Manager groups aready contain all of the information needed to add new items 
quickly.    You can use this feature whenever you install a new application in Program 
Manager that you also want in your menus.    Once the new group(s) are added, you can 
rearrange, and customize each item to suit your tastes.
To copy one or more Program Manager groups

1. Open the group menu that you want to add a Program Manager group to. 
2. Select the item in the group where you want to insert the new group.
3. From the Edit menu, choose Program Manager. 

Or click the right mouse button over the focused item and choose Program Manager.
4. In the Program Manager dialog box, select the group or groups you wish to insert, and

then choose the Insert button. 
5. Choose the Close button to return to the editor. 

See Also...
Program Manager Dialog



Copying Menu Items
When you copy a menu item, the original stays in the source group. You create a duplicate in
the destination group. 
To copy a menu item

1. Select the menu item you want to copy. 
2. Press and hold down CTRL while dragging the menu item from its current location to 

the destination-group menu. 
3. Release the mouse button and CTRL key when the mouse is inside the destination-

group menu, positioned where you want the copy to be placed. 
If the menu item you copied was a Program item, KickEdit will create a copy of the 
program item and place it where you dropped it.    If it was a group item, KickEdit will 
copy the group and all of its contents, and place it where you dropped it. 

You can also copy a menu item by choosing the Copy and Paste commands from the Edit 
menu. 



Moving Menu Items
You can move a menu item from one group to another, or somewhere else in the same 
group.    When you move a menu item to another group, it is removed from the source group.
To move a program item to another group

1. Select the menu item you want to move. 
2. Drag the menu item to the destination-group menu. 
3. Release the mouse button when the mouse is inside the destination-group menu, 

positioned where you want the item to be moved. 
If the menu item you moved was a Program item, KickEdit will move the item to 
where you dropped it.    If it was a group item, KickEdit will move the group and all of 
its contents to where you dropped it. 

You can also move a program item by choosing the Cut and Paste commands from the Edit 
menu. 



Deleting Menu Items
When you delete a menu item, it is removed from its group.    If the item is a Group item, 
then its contents, as well as any sub-groups are deleted.
To delete a menu item

1. Select the menu item you want to delete. 
2. From the Program Manager Edit menu, choose Delete. 

Or press DEL. 
Or click the right mouse button over the focused item and choose Delete.

3. In the Delete dialog box, choose the Yes button. 
Or press ENTER. 




